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1 DISCLAIMER 

OPTIKON 2000 S.p.A. requires the user of this system to carefully read  specific 
warnings found in this manual. It is responsibility of the user to provide its personnel 
with a thorough understanding of the equipment operation before use. In no event 
shall Optikon 2000 S.p.A. be liable for any injury, incidental or consequential 
damages incurred by the purchaser, users or patients as a result of operation of the 
product.  
Use of this system is a matter of professional medical judgment in all cases. Optikon 
2000 S.p.A. is not responsible for any clinical problem resulting from mishandling this 
equipment and makes no medical recommendations. 
Optikon 2000 S.p.A. declares to be liable for safety, reliability and performance only 
if: 

• upgrades, calibrations, repairs are carried out by OPTIKON 2000 S.P.A. 
authorized personnel 

• the system is used in accordance with its instructions for use 

• the mains electric installation to which the system  is connected complies with 
the IEC or UL Safety Regulations 

 
IMPORTANT NOTICE 
Every effort has been made to have all the illustrations and information 
accurately represent the product and its operation as it actually was at the time 
this operation manual was printed. Changes in some items may be made 
during the life of this manual, so that we may effectively continue to meet the 
requirements of users. On occasion, these changes may be made without 
notice. 
 
 
OPTIKON 2000 S.p.A. 

Via del Casale di Settebagni, 13 
00138 Rome Italy 

Phone +39 06 8888355  
Fax +39 06 8888440 
e-mail sales@optikon.com 
www.optikon.com 

 

NOTICE: Information contained in this manual is proprietary with Optikon 2000 S.p.A. 
reproduction of any part or whole may only be performed with written permission from 
OPTIKON 2000 S.p.A. 
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2 LIMITED WARRANTY CONDITIONS 
All OPTIKON 2000 S.P.A. equipment and accessories sold and installed in the 
European Union are guaranteed against defective workmanship and faulty parts for 
ONE YEAR, from the date of the invoice. Warranty on consumable materials is 
limited to the first use. 
Please, inquire with your local Optikon Distributor for warranty conditions in countries 
outside the European Union.  
All items under warranty will be repaired or replaced free of charge. 
Warranty includes the research of causes of the faults, reparation of the defect and a 
final inspection of the unit, or part(s). 
This warranty does not cover the results of misuse, accident, abuse and tampering or 
alteration done by anyone other than personnel authorized by OPTIKON 2000 S.p.A. 
OPTIKON 2000 S.P.A. reserves the right to ascertain, in case of faults, whether or 
not the equipment and/or its accessories have been altered, tampered with, in any 
way, or have been damaged by improper use.  
OPTIKON 2000 S.P.A. also reserves the right to modify the equipment and/or its 
accessories whenever operating techniques necessitate modification(s). 
No warranty will be recognized if serial number of the equipment and/or accessories 
attributed by OPTIKON 2000 S.P.A. is missing, tampered and/or not clearly readable. 
Warranty does not include expenses for return shipment of equipment and 
accessories: all expenses for transport, packing etc. are to be borne by the 
purchaser. 
In case of an expressly requested intervention of our technicians, all travel and hotel 
expenses will be debited to the client. 
OPTIKON 2000 S.P.A. cannot be held liable for damages caused by transportation. If 
this is the case, the customer should apply at once to the carrier that handled the 
consignment. 
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3 WARNINGS 
General 

• The Keratron® Scout has been developed and optimised to measure human 
eyes.The use and the evaluation of the Keratron® Scout in conditions that not 
comply with this manual, or made by using surfaces having a reflectivity or a 
shape which is far from those typical of human eyes (for example: contact 
lenses, surfaces having discontinuity in the tangent or concavity  in any of its 
section profiles, or surfaces such to create multiple reflections  or 
disappearance of some mire) cannot insure to have the same degree of 
accuracy and thus it is strongly discouraged. 

• Situations that create mires jamming can happen on human eyes in limited 
areas. This must be prevented by insuring a good tearing and good image 
acquisitions (see in particular the chapters dedicated to the eye acquisition and 
the last page of this manual), and eventually corrected by properly using “Photo 
Process” Editing functions. Therefore, you can either adjust mires detection 
parameters or eventually discard artefacts . In any case, the user must 
individually check that the mires reconstruction has been adequate before 
accepting the topographic resulting data as valid. 

• Use of accessories and cables other than those provided with the unit may 
result in an increase of the emissions or in decreased immunity of the system. 
Portable and mobile communications equipment can affect  the performance of 
the unit.  

• Carefully follow the instructions when installing and using the unit , in order to 
prevent harmful interferences with other devices in the vicinity. If the unit causes 
harmful interferences to other devices (determined by turning the unit off and 
on), the user is encouraged to try to correct the interference by one or more of 
the following measures:  

• Reorient or relocate the other devices. 
• Increase the distance between the equipment. 
• Connect the unit into an outlet on a circuit different from that to which the other 

devices are connected. 
• Consult your local distributor or  OPTIKON 2000 technical assistance.  

 

 

Environmental 
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 Recycle the Ni-Cd batteries or dispose properly  

 

• Do not dispose of Keratron® Scout as unsorted municipal waste. Collect it 
separately according to the local laws/regulations on disposal of waste electrical 
and electronic equipment.   

 

Electrical 

• NiCd batteries: Warning!  
o The batteries inside this module can explode or leak if put on fire 
o Do not open the Battery Module  and do not short-circuit its electric 

contacts. 
o Do not wet or put into water. You could have electrical shocks or 

hazard. 

• Caution when inserting/ de-inserting the Docking Base-VK cable 

To insert the cable: 

o Turn the base off before plugging the cable to VK. 

o Check the connector orientation. 

o Insert perpendicularly. 

o Tight the blocking screws. 

To unplug: 

• Turn the instrument off before unplugging the cable to the VK. 

• Loose the blocking screws. 

• Remove without teasing. 
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• Plug the power chord only of a PC having an insulation class II of 

EN60950 (shortly represented with the symbol  ), i.e.: compliant EN 
60601-1 standard and then lock it by screwing the Perspex Plate in its 
place 
The Mains socket-outlet of the OR trolley must be used only to energize 
equipment compliant with EN 60601-1 standard (or class II of EN60950). The 
risks that are encountered when equipment, whose compliance with EN 60601-
1 is unknown, is connected to the trolley are: 

• the EARTH LEAKAGE CURRENT of the equipment could lead to 
an excessive EARTH LEAKAGE CURRENT of the system, in 
normal condition; 

• the ENCLOSURE LEAKAGE CURRENT of the equipment could 
lead to an excessive ENCLOSURE LEAKAGE CURRENT of the 
system, in single fault conditions (interruption of common protective 
earth conductor). 

 

 
Mechanical 

• Block the handle before removing the Videokeratoscope from the staff  The arm 
of the OR trolley base is weight-balanced for an average weight of the Scout VK. 
Prior to remove the VK, you should block the spring mechanism within the arm by 
the proper handle, or the staff can hurt your face. 

• Insert the pin of the Slit Lamp Adaptor into the Slit Lamp hole before tightening 
the hand-wheel. Tightening of the knob with the pin only partly inserted can 
permanently deform it.  
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4 SYMBOLS 
Table shown below reports some symbols approved by I.E.C. and their meaning. 
When there is not enough room, they are frequently used on medical equipment to 
enable an easy and fast communication of information and warnings. Sometimes two 
or more symbols may be assembled to obtain a special meaning. 
These symbols are used in the Keratron® Scout  and Docking Base labels. Before 
starting to use the units, you should familiarize yourself with them and their definitions 
shown in the table. 
 

SYMBOLS PUBLISHED BY THE IEC 
 

 

SYMBOL 
 

DESCRIPTION 
 

 

 
ALTERNATING CURRENT 

 

 
DIRECT CURRENT 

 

 
PROTECTIVE EARTH (GROUND) 

 
ATTENTION, CONSULT ACCOMPAINING DOCUMENTS 

 
 

 
OFF (POWER: DISCONNECTION FROM THE MAINS) 

  

 
ON (POWER: CONNECTION TO THE MAINS) 

 
 

 
 

TYPE B 
PART APPLIED TO THE PATIENT (BODY) 

 

 
 

TYPE BF 
FLOATING PART APPLIED TO THE PATIENT (BODY-

FLOATING) 
 

 
 

CLASS II EQUIPMENT  

 

  
DANGEROUS VOLTAGE 

 
SEPARATE COLLECTION OF WASTE ELECTRICAL/ELECTRONIC 

EQUIPMENT 
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5 GENERAL INFORMATION 

5.1 SYSTEM DESCRIPTION 

The KERATRON® SCOUT is a Modular “Computer Assisted 
VideoKeratographer” (also said CAVK in the literature) that, just like the 
KERATRON®, is designed to measure the shape of the cornea and to represent it as 
symbolic colour map of the corresponding axial or refractive powers, of its local 
curvatures or of its elevations in several formats (corneal topography). 
 
The KERATRON® SCOUT is made of: 

• a Videokeratoscope (VK), for the acquisition of the image of mires reflected 
on the eye,  

• either a table-top Docking Base or a OR Trolley base for intra-operative use, 
to power supply the VK and to communicate via Universal Serial Bus (USB) of 
any PC (not included) to the VK itself  

• a selection of Adapters i.e. a Slit Lamp Adapter and Cable, a Battery 
Module, and an Head Rest.  

 

These modules, with some additional accessories like a Scout “far” Mires Cone 
and Sterile Sleeves, can create a system to allow to get a corneal topography in one 
or more of the following operating conditions: 

• On a generic Slit Lamp, with the Slit Lamp Adapter inserted into the hole for 
accessories  of the slit lamp itself and a supplied cable inserted between the 
VK and the Docking base 

• Portable, with a specific battery module inserted under the VK and in the 
docking base, and a head-rest inserted onto the VK.  

• Intra-operative, inserting the VK into a staff of the OR Troll base, with a weight 
balanced arm, which both supports and power supply it 

 
The VK carries 28 mires, which are shaped as back-lighted concentric rings, 
alternatively 14 black and 14 whites, arranged into the internal conical surface of a 
cone, made of transparent perspex, called Mires Cone which is removable and 
which carries a opto-electronic couple, made of an IRED and a photo-transistor, set 
at two opposite sides of its external edge. 
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The Cone is back illuminated by the Lamp Board which contains a tight array of 
LEDS. Behind the Lamp Board there are the fixation led, focused at a large distance, 
and the TV Camera. 
The photoelectric couple at the edge of the optical head intercepts the eye vertex 
when this is at the preset distance from the optical head. An electronic circuit (EPCS) 
eliminates the background light and measures the “degree of coverage”, which is 
used to accept the acquisition only within a preset range. An array of 5 LEDS at the 
right hand side of the TV monitor of the VK, indicates the operator how to move forth 
and back towards the eye. If the eye is not at the right distance the image capture will 
be inhibited. 
 
The operator thus can only take images, by pressing a footswitch or the OK 
pushbutton, only when the patient eye is at a preset distance, which is the same 
distance at which the instrument was formerly calibrated on a sphere having a known 
curvature radius. 
During a test, 2 or 3 photos are usually taken on each eye, then they are processed 
by algorithms to reconstruct the shape of the cornea at more than 7000 points 
arranged at the crossways between the 28 black-to-white and white-to-black mire 
borders and 256 radials or “meridians”. 
Graphic routines then interpolates and traces this values in the form of color maps. 
 

The center of the rings is the corneal vertex, that is the point of the cornea which is 
closer to the observing TV-camera, and that is an important reference point for all 
corneal maps. The entrance pupil is also detected. 
 

5.2 TECHNICAL SPECIFICATIONS  

 
PARAMETER SPECIFICATION 
Manufacturer:...............................  OPTIKON 2000 S.p.a. 

 via del Casale di Settebagni, 13 

 00138 Rome - Italy 

Model: ..........................................  Keratron® Scout 

Regulatory compliance: ..............  93/42/EEC Medical Devices Directive (MDD) 

Technical standards:  EN 60601-1 ; EN 60601-1-1 ; 
 EN 60601-1-2  
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PARAMETER SPECIFICATION 
 
 
ENVIRONMENTAL SPECS 
Storage: .......................................  temp range -10°C to +60°C,  

  humidity 0-100% (cond.included) 

  atm. pressure 500 to 1060 hPa 

Operation: ....................................  temp range 0°C to +40°C,  

  humidity 0-90% (non condensing) 

  atm. pressure 700 to 1060 hPa 
   
ELECTRICAL SPECS 

DOCKING BASE AND OR TROLLEY 
Input voltage: ...............................  100/120/220/230-240 V A.C. select. 

Frequency:...................................  50/60 Hz 

Power consumption: ....................  60 VA 

Line fuses: ...................................  220/240 Volt: 1 A T 

 100/120 Volt: 2 A T 

KERATRON® SCOUT 
Input voltage: ...............................  14-18 Vdc supplied by the Docking Base, by the Battery  

or by the OR Trolley 

Power consumption: ....................  28 VA 
 
ACCURACY 
 
Simulated K-Readings: ................ Within +/- 0.25D on a normal cornea. 

Focusing ...................................... BFS deviation: with Slit Lamp Adapter typical within+/0.15D   

 Within +/- 0.25D handheld.To be checked by the 
“repeatability check” function. 

Misalignement.............................. Mean deviation on the map: +/- 0.1 with misalignement up 
to 1mm.  
 
EQUIPMENT CLASSIFICATION ACCORDING TO IEC 60601-1 
Type of protection against electric shock : 

Docking Base...............................  Class I 

OR Trolley....................................  Class I 

Keratron® Scout ...........................  Class II 

Cod. 161204EN 5-3 2008-12-03 Rev.B 



Keratron® Scout                                                       Installation and Operating Manual 
OPTIKON 2000 

  

Degree of protection against electric shock: 

Docking Base...............................  Type B 

OR Trolley....................................  Type B 

Keratron® Scout ...........................  Type BF 

 

Degree of protection against harmful ingress of water: 

Docking Base...............................  Ordinary 

OR Trolley....................................  IPX1 

Keratron® Scout ...........................  Ordinary 

OR Footswitch .............................  IPX8 

 
NOTE 
The switches located inside the footswitch are immersion-proof (protection class:IPX8), therefore this 
accessory is suitable for use in operating room environment 

 
Degree of safety of application in the presence of a flammable 

anaesthetic mixture:.....................  not protected 

 
Mode of operation........................  Continuos operation 

 
DIMENSIONS 
DOCKING BASE 

Height: .........................................  80 mm 

Width:...........................................  250 mm 

Depth: ..........................................  150 mm 

Weight:.........................................  about 2200 g 

 
KERATRON® SCOUT 

Height: .........................................  240 mm 

Width:...........................................  280 mm 

Depth: ..........................................  100 mm 

Weight:.........................................  about 1000 g 
BATTERY MODULE 

Height: .........................................  95 mm 

Width:...........................................  260 mm 
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Depth: ..........................................  120 mm 

Weight:.........................................  about 500 g 
 
OR TROLLEY BASE 

Height: .........................................  1400 mm 

Width:...........................................  600 mm (900 with max arm extension) 

Depth: ..........................................  600 mm (900 with max arm extension)   

Weight:.........................................  about 35 Kg 

NOTE: 
1) Weight and dimensions shown are approximate. 
2) Specifications are subject to change without notice 

5.3 EMC TABLES 

5.3.1 GUIDANCE  AND MANUFACTURER’S DECLARATION – 
ELECTROMAGNETIC EMISSIONS 

 

The Keratron® Scout  is intended for use in the electromagnetic environment 
specified below. The customer or the user of the Keratron® Scout should assure 
that it is used in such an environment.  
 

Emissions test  Compliance Electromagnetic Environment – Guidance  

RF emissions 
CISPR 11 Group 1   

The Keratron® Scout uses RF energy only for its 
internal function.  
Therefore, its RF emissions are very low and are 
not likely to cause any interference in nearby 
electronic equipment. 

RF emissions 
CISPR 11 Class B 

Harmonic emissions 
IEC 61000-3-2 Class A 

Voltage fluctuations/Flicker 
emissions  
IEC 61000-3-3 

Complies 

The Keratron® Scout is suitable for use in all 
establishments including domestic 
establishments and those directly connected to 
the public low voltage supply network that 
supplies buildings used for domestic purposes. 
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5.3.2 GUIDANCE  AND MANUFACTURER’S DECLARATION – 
ELECTROMAGNETIC IMMUNITY 

The Keratron® Scout is intended for use in the electromagnetic environment 
specified below. The customer or the user of the Keratron® Scout should assure 
that it is used in such an environment. 
 

Immunity test IEC 60601 test level Compliance level Electromagnetic Environment - Guidance 
Electrostatic discharge 
(ESD) 
IEC 61000-4-2 

• ±6 kV contact 

• ±8 kV air 

• ±6 kV contact 

• ±8 kV air 

Floors should be wood, concrete or ceramic 
tile. If floors are covered with synthetic 
material, the relative humidity should be at 
least 30% 

Electrical/fast 
transient/burst 
IEC 61000-4-4 

• ±2 kV for power supply lines  

• ±1 kV for input/output lines 

• ±2 kV for power supply 
lines  

• ±1 kV for input/output 
lines 

Mains power quality should be that of a 
typical commercial or hospital environment.  

Surge 
IEC 61000-4-5 

• ±1 kV differential mode 

• ± 2kV common mode 

• ±1 kV differential mode 

• ± 2kV common mode 

Mains power quality should be that of a 
typical commercial or hospital environment.  

Voltage dips, short 
interruptions, and voltage 
variations on power supply 
input lines   
IEC 61000-4-11 

• <5% UT (>95% dip in UT) for 
0.5 cycle 

• 40% UT (60% dip in UT) for 5 
cycles 

• 70% UT (30% dip in UT) for 25 
cycles 

• <5% UT (>95% dip in UT) for 5 
sec 

• <5% UT (>95% dip in UT) for 
0.5 cycle 

• 40% UT (60% dip in UT) for 5 
cycles 

• 70% UT (30% dip in UT) for 
25 cycles 

• <5% UT (>95% dip in UT) for 
5 sec 

Mains power quality should be that of a 
typical commercial or hospital environment. 
If the user of the Keratron® Scout requires 
continued operation during power mains 
interruptions, it is recommended that the 
Keratron® Scout be powered from an 
uninterruptible power supply or a battery. 

Power frequency (50/60 
Hz) 
magnetic field 
IEC 61000-4-8 

3 A/m Not applicable.  
The equipment does not 
contain any magnetically 
sensitive components.? 

Power frequency magnetic field should be 
at level characteristic of a typical location 
in a typical commercial or hospital 
environment.  

Conducted RF 
IEC 61000-4-6 
 

Radiated RF 
IEC 61000-4-3 

3 Vrms 
150 kHz to 80 MHz 
 

3V/m 
80 MHz to 2.5 GHz 

3 Vrms 
 
 

3V/m 
 

Portable and mobile RF communications 
equipment should be used no closer to any 
part of the Keratron® Scout, including 
cables, than the recommended separation 
distance calculated from he equation 
applicable to the frequency of the 
transmitter.  
 
Recommended separation distance:  
d= 1.2 √P 
d= 1.2 √P  80MHz to 800 MHz 
d= 2.3 √P  800MHz to 2.5 GHz 
where P is the maximum output power 
rating to the transmitter in watts (W) 
according to the transmitter manufacturer 
and d is the recommended separation 
distance in metres (m). 
Field strengths from fixed RF transmitters, 
as determined by an electromagnetic site 
survey a, should be less than the compliance 
level in each frequency range. b  
Interference may occur in the vicinity of 
equipment marked with the following 
symbol:  

A 
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NOTE: 
UT is the a.c. mains voltage prior to application of the test level 
Note 1:At 80 MHz and 800 MHz, the higher frequency range applies.  
Note2:These guidelines may not apply in all situations. Electromagnetic propagation is affected by  

   absorption and reflection from structures, objects and people. 
a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) and 

land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be 
predicted theoretically with accuracy. To access the electromagnetic environment due to fixed 
RF transmitters, an electromagnetic site survey should be considered. If the measured field 
strength in the location in which the Keratron® Scout is used exceeds the applicable RF 
compliance level above, the Keratron® Scout should be observed to verify normal operation. If 
abnormal performance is observed, additional measures may be necessary, such as re-orienting 
or relocating the Keratron® Scout unit. 

b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m. 

5.3.3 RECOMMENDED SEPARATION DISTANCES BETWEEN PORTABLE AND 
MOBILE RF COMMUNICATION EQUIPMENT AND KERATRON® SCOUT  

Keratron® Scout is intended for use in an electromagnetic environment in which 
radiated RF disturbances are controlled. The customer or the user of Keratron® 
Scout can help preventing electromagnetic interference by maintaining a minimum 
distance between portable and mobile RF communications equipment 
(transmitters) and Keratron® Scout as recommended below, according to the 
maximum output power of the communications equipment. 
 

Separation distance according to frequency of transmitter 
(m) 

Rated maximum 
output power of 
transmitter  (W)  150 kHz to 80 MHz  

d= 1.2 √P 
80 MHz to 800 MHz 

d= 1.2 √P 
800 MHz to 2.5 GHz 

d= 2.3 √P 
0.01 0.12 0.12 0.23 
0.1 0.38 0.38 0.73 
1 1.2 1.2 2.3 
10 3.8 3.8 7.3 
100 12 12 23 

 
For transmitters rates at maximum output power not listed above, the 
recommended separation distance in meters (m) can be estimated using the 
equation applicable to the frequency of the transmitter, where P is the maximum 
output power rating of the transmitter in watts (W) according to the transmitter 
manufacturer. 
NOTE: 
Note 1-At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.  
Note 2-These guidelines may not apply in all situations. Electromagnetic propagation is affected by 
absorption and reflection from structures, objects,  and people. 
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5.4 CIRCUIT DIAGRAMS 

Optikon 2000 S.p.A. will make available on request circuit diagrams, component part 
lists, descriptions, calibration instructions, or other information which will assist the 
user's appropriately qualified technical personnel to repair those parts of equipment 
which are repairable. 
 

5.5 COMPOSITION 

MODULE CODE        DESCRIPTION 
VIDEOKERATOSCOPE 161204 VK WITH MEMORY EXPANSION AND 

PUPILLOMETRY unit complete with 28 mires 
cone, including the pupillometry lamp board, 
calibration sphere, “Keratron Scout” software 
(release 3.6 or later), user manual, and an 
internal memory expansion board to store up to 8 
photos. 

 

 162202  

(ex 
ATXE1014) 

DOCKING BASE WITH CHARGER Unit. 
Desktop support base with power cord, USB 
cable, including a module board to charge battery 
modules. 

 

  

163201  

(ex 
ATXM1079) 

 

OR TROLLEY BASE unit. wheelbase for intra-
operative use, complete with power supply cable 
and OR footswitch, for operating room. 

 

 

ADAPTER MODULES / 
KITS 

 

162206  

(ex 
ATXM1076) 

 

SLIT LAMP ADAPTOR KIT: Adaptor slide for slit 
lamp, complete with “slit lamp cable” to connect 
the VK with the docking base and footswitch. 

 

  

162205  

(ex 
ATXM4017) 

 

BATTERY MODULE 1200 mAh Battery to be 
inserted below the VK. It can be plugged into the 
Docking Base battery socket, alone or with the 
VK, to re-charge and exchange picture data with 
the PC, at the same time. Working duration after 
each charge; about 30 min. To be used with 
162208 (ex ATXM4078) 
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. 

  

162208  

(ex 
ATXM4078)  

 

HEAD REST (To be screwed onto the VK). To be 
used with 162205.  

                 

 

5.6 ACCESSORIES 

 CODE      DESCRIPTION 

 
 162210 USB/EPP INTERFACE, including one USB cable 

and Keratron Scout software CD ROM including 
USB drivers. 

 
  

162211  
(ex ATXM4079) 

 

SCOUT “FAR” MIRES CONE, including its own 
calibration sphere. 

 
  

162212 

 

SPACER FOR SCOUT SL ADAPTOR, to fit the 
SL adaptor (162206) wit SL having too close 
distance between hole and projector arm. 

 
 162216 KIT FOR ANALYSING CONTACT LENSES,which   

allows the operator  to measure the front and back 
surfaces of contact lenses. T. 

The KIT can be used with Scout software version 
3.9.0 or later. 

  

169201  
(ex GTXG4023) 

 

SCOUT CARRYING CASE. For one Keratron® 
Scout and accessories 

 
  

163202  
(ex ATXM4094) 

 

SCOUT TRANSLATION BASE WITH 
HEADREST. XYZ tabletop with joystick, 
alternative to the SL 
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196201 

 

SCOUT DISPOSABLE SLEEVE, sterile sleeve for 
intra-operatory Scout use, with standard cone. 

 
  

196203 

 

SCOUT DISPOSABLE SLEEVE FOR FAR CONE, 
sterile sleeve for intra-operatory Scout use, with 
“far” mires cone. 

 

5.7 UPGRADE KITS 

 CODE      DESCRIPTION 
 

162203  
(ex ATXE1015) 

 

Battery Charger Kit. It upgrades the discontinued  
Docking Base 162201 (ex ATXE1013)  into 
162202 (ex ATXE1014)   (Service Level). 

 

 

162204  
(ex ATXE1016) 

 

Memory Expansion Kit. It upgrades a VK 
UTXE1013 into UTXE1014 (Service Level). 

 

 

162215 

 

Keratron® Scout Pupillometry Upgrade Kit. 
“Pupillometry Lamp Board” with 140 high efficiency 
LED (80 of them are SMD amber leds, while 
others are Infrared LEDs). The instrument 
provides, beside standard topographies, 
acquisition of infrared images. Infrared permits 
accurate pupil tracking in both photopic and 
mesopic/scotopic conditions.  Pupillometry 
function is supported starting from “Scout” 
software release 3.6.0 or later, and requires the 
Scout videokeratographer firmware to be updated 
to version 3.0. (Service Level) 

 
 

 
 

IMPORTANT NOTICE: 

Cod. 161204EN 5-10 2008-12-03 Rev.B 



Keratron® Scout                                                       Installation and Operating Manual 
OPTIKON 2000 

Units produced before year 2000 or during the early months of it, to be 
updated with pupillometry function, need for the substitution of the 
“double deck board” (Main Board with code 380260 and CPU Board 
with code 380280) with the Scout Board (380290).To know the 
production year call the local distributor or Optikon 2000 S.p.A. 

5.8 NOT SUPPLIED ACCESSORIES 

 
COMPUTER minimal requirements:  Pentium III (450MHz) or superior 
 RAM 64 Mbytes (absolute minimum, expandable)

 10 GBytes Hard Disk (minimum) 

 1.44 Mbytes Floppy drive 3 ½ inches. 

 CD Rom driver 

 SVGA video board with video mode at least 
1024x768 pixels, true-color (16-32 bit). 

 USB Port 1.1 or 2.0 

 Windows ’95 o ‘98/Me.  

 Windows 2000/XP 32 bit only with USB interface 

 Windows Vista 32 bit (only from “Scout” software 
release 4.3 or later.) 

 Color Graphic printer 
SLIT LAMP Any, generic, having an 8 mm hole diameter 

(between 7.8 and 8.2 mm) within the base shaft, 
intended for a tonometer adapter. 
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5.9 DISCONTINUED CODES  

 
MODULE CODE        DESCRIPTION 

VIDEOKERATOSCOPE 161201 
(ex UTXE1013) 

VK (Videokeratoscope) PLAIN unit complete 
with 28 mires cone, calibration sphere, 
"Keratron Scout" software and user manual 

 

 161202  
(ex UTXE1014) 

VK WITH MEMORY EXPANSION unit complete 
with 28 mires cone, calibration sphere, 
"Keratron Scout " software and user manual, 
including an internal memory expansion board 
to store up to 8 photos. 

 

  

161203 

 

VK WITH PUPILLOMETRY unit complete with 
28 mires cone including the pupillometry lamp 
board, calibration sphere, “Scout” software 
(release 3.6 or later) and user manual. 

 

 

DOCKING BASE: 

 

162201  

(ex 
ATXE1013) 

 

DOCKING BASE PLAIN Unit. Desktop support 
base, with power cord and USB cable. 
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6 INSTALLATION  

6.1 INTRODUCTION 

This section details a recommended installation procedure for the Keratron® Scout 
corneal topography system.  
Follow the installation and operating instructions carefully in a step by step manner 
and, within a short time, you will have gained all the knowledge needed for 
successful operation of your Keratron® Scout corneal topography system. 

6.2 UNPACKING AND INSPECTION 

This unit has been packaged to minimize the risk of damage in shipment. Unwrap the 
package and examine the components. Handle all components with care during 
unpacking. Use caution cutting the wrapping to ensure that the cut does not 
penetrate the packing and damage the components. If external or internal shipping 
damage is discovered, notify the carrier (mail, railways or forwarding agents) and 
Optikon 2000 as soon as possible. Check the contents against the packing list and 
notify Optikon 2000 immediately of any discrepancies. 
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6.3 INSTALLATION PROCEDURE 

6.3.1 CONFIGURATION ON THE SLIT LAMP 

 

Fig.1 – Diagram of the Slit Lamp configuration 
 
To set up this configuration: 
 

1. Insert the expandable pin of the Slit Lamp Adapter (4) completely in the 
hole for accessories of your Slit Lamp and then turn its wheel in the 
direction indicated with “TIGHT”, i.e.: in the clockwise direction. This 
operation will make the pin to expand so to have a stable coupling. 
Caution: avoid expanding the pin when it is not completely the hole, 
in order not to stress its expander. 

.I

2. Insert one of the two ends of the Slit Lamp Cable (1a) under the VK (1) 
care to plug it in the direction that the two dots do match, and to insert 
it perpendicularly until the latch clicks. 

3. Insert the VK in the slit lamp adapter (take care that it is properly inserted 
in its slot (not just leaned nor sideway) until the two sphere pins will 
eventually click. 

.I
4. While the Docking Base is turned off, insert the other end of the Slit Lamp 

Cable having care to plug it in the direction that the two dots do match, 
and to insert it perpendicularly until the latch will click. 
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5. Connect the footswitch (5) to the Docking Base 
6. Connect the PC (8) to the Docking Base via a parallel cable D-sub 25 

Male/Female (the male in the PC printer port and the female in the 
connector “Computer” of the base) and turn the Docking Base on. 
Caution: use only PC having an insulation class II of EN 60950 
(shortly represented with the symbol       ), i.e.: compliant EN 60601-1 
standard, otherwise plug your PC to a mains outlet which is 
separated by the mains outlet where the Docking Base is plugged. 

 
 

 
 
 

 

Fig. 2 – Slit Lamp Cable and Slide connection  
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Fig.3 : Slit Lamp configuration: Docking Base cables connection 
 

6.3.2 “PORTABLE” (BATTERY OPERATED) CONFIGURATION 

For this configuration, referring to fig.4: 
1. Insert the Battery Module (11) under the VK and screw the white knob until 

the two parts do match tightly.  
2. Insert the Headrest (12) on the top of the VK. 
3. For a correct acquisition, follow the instructions in the paragraph “How to… 

Acquire a good image in Portable configuration” 
With the Battery Module, in particular: 

1. Turn the VK on, by pressing the OK pushbutton for about 1 second. At this 
point, you can acquire up to two images (8, with the memory expansion). 
The numbered LED at the left side of the display panel show how many 
pictures you have taken. 

2. In order to download the images to the PC, insert the VK along with its 
battery module into the Docking Base and then start “Acquire” “New 
Image” at the PC. If you turn the base off while the VK is inserted, this will 
turn it off too. 

3. To reload the battery, you can leave the complete instrument, or the 
battery module alone, at all time inserted in the base switched ON. The 
normal complete charge time is about 15 hours, and that way the battery 
can stay in its place at all times. If a fast charge was necessary, just push 
the “fast charge” button. Removing shortly the battery, or switching off the 
base (or a battery warm-up), will turn back the base to the normal charge. 
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 Fig.4 – Handheld Configuration 

 

It’s strongly suggested, after every move, to make a calibration, before the test. 

 

NOTES: 
When the battery is almost out of charge, a red led will turn on the display panel, and a random be-
beep will warn you that you still have a few minutes in order to download and save all the images, and 
to put it back to charge, too. You should then remember to recharge the battery as soon as possible 
(within days). 

The red battery LED could turn of in case the battery had warmed up too much. In either case, you 
should leave the instrument to rest in the Docking Base for a while. 

When the VK with the Battery Module is not in use for about 90 seconds then, in order to spare the 
batteries, a timeout circuit will turn off the cone lights and the display. The OD and OS LED will keep 
blinking.    To wake up back the VK after timeout, just press any key (i.e.: the OK button).  
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6.3.3 INTRA-OPERATORY CONFIGURATION 

For this configuration (refer to Fig.5): 
 

1. Caution: always block the wheels under the basement of the OR 
Trolley Base (18).  

.I
2. Turn the OR base switch OFF. Connect the PC to the OR trolley base 

through a USB cable, connect the OR Footswitch to the base and turn the 
OR base ON.  

.I
3. Insert the VK into the staff (22) and connect the connector to it. Caution: 

before inserting the connector in the VK take care that the OR Trolley 
Base is OFF. Tight both the side knobs (then the Mires Group (23) can be 
tilted by the knobs themselves). Then release the arm (17) by loosing the 
knob located on the arm itself. 

4. Caution: for a sterile use, it is appropriate to envelope the entire VK 
by a disposable Sterile Sleeve. For the proper insertion and usage of 
the sleeves, refer to the relevant instruction for use. 

5. At this point, the images can be acquired by setting the VK parallel to the 
patient and using the keys upside-down on display (21) (with the help of an 
assistant, if it is not covered with the Sterile Sleeve). To take the image you 
can use the footswitch or the OK button at the bottom left, by keeping it 
pressed and getting close to the eye until the acquisition is automatically 
taken. The last image can be canceled by the CLR button, or it can be 
processed by the P key and the test saved by the S key. As an alternative 
the acquisition can be activated from the PC keyboard, by pressing 
“ctrl”+”D” or “ctrl”+”S”. You can also toggle “Auto-Trigger” by 
“ctrl”+”Spacebar” (Caution to avoid harsh movements and to clear bad 
shots). To enable  P-S-C keys, and for more explanation about “auto-
trigger” function, refer however to Options “Process” and to the ”Help-on 
line” directly on your PC. 

WARNING 
Caution: use only PC having an insulation class II of EN 60950 (shortly represented with the 
symbol       ), i.e.: compliant EN 60601-1 standard.  

Otherwise plug your PC to a mains outlet independent from the OR Trolley. In such a case the 
PC (as well as the printer, if it is connected during the operation) must also be kept at a 
minimum distance of at least 1mt from the patient just like any non-medical equipment. 
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Fig.5 - Intra-Operatory Configuration 

6.4 SOFTWARE INSTALLATION 

6.4.1 INTRODUCTION 

The Keratron Scout software does not require special instructions because it is driven 
by an appropriate Setup program is usually installed when you receive the system.   
The following precautions are recommended:  
 

1. The PC must be an IBM compatible, with an operating system Windows 
98/Me or Windows 2000/XP only with USB interface. 

2. The screen properties can be set in any mode, but it must be a “true color” 
(65K or 16M colors). It is however recommended a screen size of at least 
1024x768 pixels. 

3. Do not alter any of the system files installed by the Keratron Scout Setup 
software, nor any file in the Database unless you have a specific 
competence on the PC and LAN management. If such is the case, refer to 
the Service Manual.  
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The update of the software of your Keratron® Scout is easy and does not alter your 
database, or your instrument calibration, or your preferred settings that are stored in 
the hard disk. 
You must first uninstall the previous version, and then install the updated version of 
“Keratron Scout Setup”. The most recent version can be also downloaded after 
registration from the web Internet site of Optikon 2000: http://www.optikon.com/. 
 

NOTE : 
In Windows 2000 and XP operating systems, you must have system 
administration (Administrator) privileges to install the software. 

 
NOTE: 
A printer has to be installed and set as default before running the 
Scout.exe software 

 
 
 
6.4.2 DOWNLOAD THE KERATRON SCOUT FROM THE WEB 

Go to the Web site http://www.optikon.com/scoutmain.htm 
The procedure is different depending on if you are registered or not. 
 
IF YOU ARE NOT REGISTERED 

• Click the hyperlink “Go to the registration page” 

• Fill all the items, and click the “Register Me” button. 

• You will be enabled to download within 24 hours, receiving a confirmation e-
mail from Optikon 2000. 

 
IF YOU ARE ALREADY REGISTERED 

• Click the hyperlink “Go to the download page” 

• When prompted, write your Username and Password, then click OK button. 

• Create an empty folder on your Hard-Disk (e.g. “C:\ScoutSW”) 

• Right-click on the hyperlink Setup.exe, choose “Save Target As” when 
prompted and save it in the folder you have created. 
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6.4.3 KERATRON SCOUT SOFTWARE INSTALLATION 

Both if you are installing the Keratron Scout software from the Web and if you are 
installing from CD, remove any previous Scout versions from your PC before install 
the new Scout software. 
 
If you are installing the software from the CD-ROM : 

• Insert the CD-ROM into the reader. 

• Wait a few seconds, an HTML page will be loaded. 

• Choose the “English” hyperlink. 

• Choose the “Install Scout Rel xx.xx, for Keratron Scout &  Keratron Bridge“ 
hyperlink. 

• Choose “Run” when prompted. 
 
If you are going to install the downloaded version: 

• Using “Windows Explorer” select the folder where the downloaded files are. 

• Run the “Setup.exe” by double-clicking on it. 
 

Indipendently if the installation has been made from CD or downloaded version, the  
setup procedure could notify some messages, like DLLs version conflicts etc. 
See the troubleshooting section in this manual (see 9.1.1) for the proper action. 
 
6.4.4 IMPORTING OLD KERATRON® TESTS 

The exams file format of Keratron® Scout is different from the old Keratron one®. Old 
exams to be used in Scout software have to been “translated”. This operation can be 
done with the import function:   

• From menu bar choose “File” -> “Import tests…”. 

• Select the folder that contains the tests and click the OK button. 

• The “Test Manager” window will appears. 

• Click on the “Import” icon. 
 
Before importing  it’s advisable to have these remarks: 
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• If there are many tests do not import them all together, try to import a little 
group, and check them. 

• Make attention to the list showed il the “Test Manager”, verify that each name, 
surname, sex, DOB, test number and test date are imported correctly. 

• You can change the import parameters using “Tools” -> “Options…”, select the 
“Database” section and click on the “Conversion Options…” button. 
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6.4.5 KERATRON SCOUT SOFTWARE ANATOMY 

 
 
 
 
 
 
 
 
 

 

 
 
 
 
 

Cod. 161204EN 
Scout Trialsets folder (void after first installation).
 
Keratron Scout system files. Be careful to this folder!!
 
Put here imported print-templates, and those you create new.
 The SW puts here temporary files.
Default database folder.
 
 
  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

*.tb Toolbar settings 
Scout.ini Software settings 
*.cnt Help contents files 
*.hlp Localized help files 
ScoutTSE.exe Trial-set editor for Keratron Scout lenses. 
Scout.exe Main program 
ScoutPad.exe Print template generator 
Test Scout.exe Test tool Scout communication 
Test Bridge.exe Test tool Keratron communication 
Color.ini List of available lens colors 
Material.ini List of available lens material 
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6.4.6 SCOUT CUSTOMIZATION 

You can customize/change SW behaviour and toolbar buttons. 
 
Change the SW behaviour using the “Options” window under the “Tools” menu. 
Customize the toolbars simply right-click on it. 
 
6.4.7 USB DRIVERS INSTALLATION 

With the computer at the Windows desktop, insert the supplied CD-ROM that 
contains the drivers. 
First, connect the cable to the PC USB Port , and then to the USB port of the Docking 
Base. 
Switch the Docking Base on and follow the instructions below according to your 
Operating System. 
 

Windows 9x/ME 
As the interface is a Plug & Play device the operating system will recognize it and will 
display the Dialog Box “Add New Hardware Wizard”. 
Now: 

Click on the Next button 

A new windows will appear and select the radio button “Search for the best driver 
for your device (Recommended)”  
then go on clicking the Next button. 
 

In the next window select only “Specify a location”. Then clicking on the “Browse” 
button select the directory software\drivers\EPPUSB_Bridge\Win9x in the CD 
ROM as shown in the figure 1.  
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Figure 1 

 
 

Click the Next button. 
 

The computer will display a message confirming that the suitable driver has been 
found and is going to install it. 

Continue with the Next button. 
 

“Add New Hardware Wizard” will end the installation with Figure 2 
 
 

 
Figure 2 
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Click on the Finish button. 
 

Windows 2000/XP 
 

NOTE : 
You must have system administration (Administrator) privileges to 
install the USB drivers. 

 

As the interface is a Plug & Play device the operating system will recognize it and will 
display the Dialog Box “Found New Hardware Wizard”  

Click on the Next button. 

Select, in the next window, the radio button “Search for a suitable driver for my 
device (Recommended)” and then click the Next button.  

Among the options of the next window select only “Specify a location” and click the 
Next button. 
Then, the operating system will ask for the location of the files to copy. 

You have to specify the software\drivers\eppusb_bridge\Win2k directory for 
Windows in the box below “Copy manufacturer’s files from:”.  

Click  the OK button to start the installation. 

The installation will be started by the click of the Next button in the window that 
confirms that a suitable file was found and it is ready for installation. 
 
 

 
Figure 3 
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The window displayed in the Fig.3 confirms that the driver has been properly installed. 

Complete the  by clicking the Finish button. 
 
6.4.8 CONFIGURING KERATRON SCOUT SOFTWARE 

The next phase consists of enabling the USB communication in the Keratron Scout 
software. 
Start the Keratron Scout software. In the menu bar select Tools then select the item 
Option.... 
The dialog box shown in fig.4 will display. 
 

 
Figure 4 

 
Select the tab labeled “Print” and the dialog box will display as shown in fig.5. 
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Figure 5 

 

Select in the Port Type frame the USB option then press OK. 
 
6.4.9 UNINSTALL KERATRON SCOUT SOFTWARE 

We can imagine two different methods: the first one uses the Windows standard 
uninstall procedure : 

1. Start “Control Panel”. 
2. Click on “Add/Remove Programs” icon. 
3. Select the “Keratron Scout“ item. 
4. Click on the “Add/Remove” button. 
5. Follow the instructions, if the uninstall procedure asks you to remove some 

DLLs, click on the “Yes to all” button. 
 
The second one calls directly a specific unistall utility: 

1. From Windows menu “Start” -> “Programs” -> “Keratron Scout”, choose 
“Uninstall Keratron Scout” item. 

 
For both methods verify that these files has been really unloaded/deleted from the 
PC. 
 

• C:\Keratron\Scout.exe 

• C:\Keratron\ScoutTSE.exe 
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• C:\Keratron\ScoutPad.exe 

• C:\Keratron\Test Bridge.exe 

• C:\Keratron\Test Scout.exe 
 
Finally, restart your PC. 
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7 SCREEN AND COMMANDS DESCRIPTION 

7.1 INTRODUCTION 

In this section only the basic operation are described. For a more comprehensive and 
updated description of the software functions, refer also to the HELP menu 
(command or key “?” on the menu bar).

7.2 CALIBRATION 

To ensure accurate measures, you are suggested to do the Keratron® Scout 
calibration often. In particular: 
 

• After any transportation or installation. 

• After any Mires Cone removal and change. 

• On a periodical base (e.g.: daily or after each turn on) depending on use. 
 
To run the calibration: 

• Check, that the sphere radius saved into the PC matches the one reported on 
the back of the calibration sphere itself. If no, then set it into the CALIBRATE 
menu (just the first time after installation). 

• Start the calibration from the menu or the CALIBRATE button on the PC 
screen (if the VK is connected to the base through a cable and it is NOT 
battery operated) 

• Press either OD or OS on the VK to start the acquisition 

• Hold the body of the calibration sphere between the thumb and the third finger, 
and fit it well and steady onto the mires cone. 

• Turn the back knob by the second finger, until the sphere vertex turns the OK 
LED on. Turn slightly back and forth so to be sure to be in the middle of the 
OK zone. 

• Press the OK button and wait that the image is transferred to the PC and 
accepted automatically. If the software cannot find the center automatically, 
then follow the instructions on the screen. 

  
If the instrument is battery operated (“portable” configuration), after the acquisition, it 
shall be inserted firmly in the Docking base, and then run CALIBRATE on the PC. 
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7.3 HOW TO ACQUIRE A GOOD IMAGE 

Acquiring an image is the most critical operation of topography. Care must be taken 
to capture the image moving slowly to the proper vertex distance every time and to 
avoid bad tearing and eyelashes artifacts (see the last page in this manual).  
An automatic focusing device located on the cone apex lets you capture images only 
if the eye vertex is at a correct working distance, provided the eyelashes do no 
interfere.  
 
From the ACQUIRE menu, select “New Image”; the IMAGE ACQUISITION window 
will appear on the display.  
Press either the OD or the OS key to select the eye to be examined; an intermittent 
sound will indicate that the instrument is ready to begin acquisition (pressing the CLR 
key will cancel the selection and allow a new one). 
 
7.3.1 THE SLIT LAMP CONFIGURATION 

When moving forward the Keratron® Scout, be careful not to hit the 
patient with the cone.  

Adjust the cone vertically and slightly rotate the adapter sideways so to avoid that the 
cone hurt the nose or the eyebrow of the patient. Adjust the height of the table and of 
the chin rest as to obtain the most stable position.  
Use the joystick of the slit lamp to center the cross on the monitor at the center of the 
rings while getting near to the eye. It is not necessary to be extremely scrupulous in 
this operation, as the software will compensate automatically the possible 
decentration. If the acquisition time should be too long, the patient eye could get tired 
and the lachrymal film could break. 
  
While centering, use the joystick of the slit lamp to get to the proper distance from the 
eye. The lower LED, with an arrow pointing upward indicates that you should move 
closer to the eye. The upper LEDS with arrows pointing downwards indicate that you 
should move back from the eye; if the arrow inverts its direction pointing upwards, the 
correct focusing has been exceeded. Correct focusing is reached when the central 
OK LED is on. 
 
You may capture up to eight images. 
Discard the bad pictures at once, if they were clearly moved or taken while the 
patient was blinking, by pressing CLR. 
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It is advisable that, as your first training experience, you take 6-8 pictures on the 
same eye and to check their repeatability by “Acquire”, “Repeatability Check” menu, 
until this is good. 
As a standard procedure, you are then suggested to take 3-4 pictures per eye in 
order to check repeatability, and then to save only the best one (or two) 
 

Caution:  
To move the Scout do not use its handle, but the slit lamp joystick. Use 
the footswitch to acquire, and avoid using the OK key.  

 
During the acquisition of an image, the Keratron® Scout emits a series of “beeps” 
changing in pitch and rhythm. This is meant to be an audio cue for the operator when 
aligning an eye for image capture. Listen to the beeps to get familiar with the cues. 
Perfect focus has its own distinct sound. The audio cues enable you to concentrate 
more on the video image on the CRT rather than on the arrow indicators. 
 

Suggestion:  To obtain a quick and reliable acquisition, go just a little closer to the 
eye than OK, ask the patient to blink then to OPEN BOTH EYES WIDE then, keeping 
the switch pressed, move back slowly and thus acquire the image automatically. If 
the patient blinks, discard the photo and repeat.  
 
Once you have captured an image by pressing the footswitch – or the OK key if the 
PC is in acquisition mode -, the image will be automatically transferred and added to 
the previous ones. If you press the CLR key, you can delete the image last taken.  
 
 
7.3.2 THE PORTABLE CONFIGURATION 

Acquisition in portable or handheld mode is affected by a larger number of perturbing 
factors than with LAF (both patient’s and operator’s movements, and possible 
rotations in 3D) and therefore it requires more experience and practice. 

  

Nevertheless, after a short training, and with the following trick-and-tips, it is possible 
to learn to take quickly results having a repeatability as good as those that can be 
obtained with the Slit Lamp configuration. 
 

1. Sit the patient so that his head touches a wall without tilting up, and so to 
stay just in a higher position than he is (fig. 6). 

2. Put the disk extension of the headrest steady on the patient’s forehead, 
possibly helping with the other hand. 
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3. Tilt the cone possibly in its horizontal position. Only with patients having a 
leaned forehead or with children orientate the cone to 5° or 10° upwards (1 
or 2 clicks). In such cases, however, you could need to be even higher 
than the patient. The cone should however approach close to the eyebrow 
(figures 7), so to avoid that the lower lid covers the eye too much (figures 
8). 

4. Press OD or OS to start acquisition. Get near to the eye until reaching the 
OK position. 

5. Take care that the protrusions of the mires cone do not hurt the 
patient’s eye!   To avoid this, it is important that you centre the reflected 
rings with the cross in the display from the very beginning and that you 
keep them centred at all time while you advance by pushing on the 
headrest up to reach the OK position. Avoid pivoting sideways the VK by 
your holding hand and instead looking for the optimal point where to place 
the headrest disk, with the help, if necessary, of the other hand.  

6. Ask to the patient to blink and then to open wide both eyes. Then get close 
by slightly overcoming the OK position, press and keep pressed the OK 
button and then get back very slowly until you get an automatic capture. 

7. If the picture is moved, then erase it at once by pressing CLR and then 
proceed with next acquisition. Capture up to 8 picture (at your first 
experience) on the same eye and 3-4 per eye, in your daily practice. On 
the PC, discard only the very moved or bad ones and then run “Process 
All”. Do “Acquire” “Repeatability Check” and repeat until you can get good 
results. Eventually save only the 1 or 2 best ones. 

 

Fig.6 Patient Operator position 
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             Fig.7 – Correct Approach                                 Fig.8 – Bad Approach 

 

NOTE:  
It is very important that the patient opens BOTH eyes VERY WIDE, to avoid typical eyelashes 
artefacts (see the last page in this manual). If the eyelashes shadows reach the horizontal line passing 
through the centre in the picture, they can fool the detection system and you will get a map with 
abnormally high curvatures. In case of doubt take more than one photo and check for repeatability. If 
necessary help the eye aperture with your fingers and re-instruct the patient to open widely. 

NOTE:  
Do not waste time to align perfectly the cross within circles. Even a 4-5 rings error generates an error 
lower than 0.1 D. It is more important that eyes are wide open. 

NOTE:   
If the tear film is bad, ask the patient to blink. If any dust or grime doesn’t go away, ask him to gently 
rub his eyelids. 
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7.4 HOW TO PROCESS, PRINT AND SAVE IMAGES 

After “Acquisition”, you can process individual images by double clicking on them, but 
it is advisable to process all of them by the “Process All” menu or icon-button. 
Processing an image means analyzing the circular mires’ reflections on the cornea to 
obtain a topographic map.  
The rings centering and tracking is made evident in the Photo-process window. Here 
you can check how and where within the map this has been made properly, without 
artifacts, and here you can intervene by adjusting processing conditions and/or 
erasing bad tracks. 
To choose the graphic representation, which will be automatically created and left on 
the desktop during processing (including the Photo-Process window), choose 
“Options” from the “Tools” menu; then choose “Processing”.  
From “Default Map Type” section choose the required representation, and then press 
OK.  
Apart from that setting if, for instance, starting from an Axial map you want the 
Curvature to be displayed, click on the above-mentioned map (the title bar is 
activated) and then, from the menu, choose “Make” “Axial”. 
To activate the various types of keratometric data, choose “Options” from the “Tools” 
menu. As an alternative, you can click on any map with the right button mouse and 
just select “Options”. 
The effect of a change in graphic options is immediately applied on all maps already 
displayed on the screen, though it can take a few seconds.  
Finally, select the “Save Test” menu or icon button.  
Discard all images except for the best one for each eye. This will save space on disk 
and will speed up review. 
If you did not do it before, fill in patient form. Always put the name and date of birth, 
the sex, the group, diagnosis and operator (see Patient Form). 
These keywords will be essential to find tests into selected groups, even when your 
database would become huge. 
To print the screen, simply choose from the “File” menu “Print Screen”. You can print 
while in Acquisition mode only if the “Transparent printing” is enabled. 
To print one or more tests, both those saved and stored and those displayed on the 
screen using print templates, by the “Print” menu or icon-button, or from the “Test 
Manager”. 
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7.5 PUPILLOMETRY 

In this chapter are described only basic information on how pupillometry images shall 
be acquired with a Scout videokeratoscope with pupillometry lamp board 
(161203/161204). 
You will find detailed information of: pupillometry functions, how pupillometry is 
represented on Keratron® Scout maps and considerations about pupillometry, in the 
on-line-Help of  “Scout software”, release 3.6 or later. 
 

IR-Pupillometry picture 
 

To acquire an IR-Pupillometry image, start image acquisition as usual, by pressing 
OD or OS on the VK display panel, then press once the inverted [P] button above the 
display (figure 9). You will see a white square at the bottom right of VK display (A) 
and the cone will darken. 
 

 

  Fig.9 – Toggle among pupillometry modes              

 

      Fig.10 – Accommodate both eyes to dark 
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Then wait for at least 10-15 seconds in order to allow the pupil time to accommodate 
to its size to dark conditions. Then acquire the dilated-pupil picture as a normal 
capture. Usually you need to take just one IR picture, whose pupil track will be then 
associated to all map views. You can however take more than one IR picture for a 
subsequent choice, or for averaging (see “Help”) 

 

IMPORTANT NOTICE 
You must keep the room illumination at a very dim level (for 
scotopic/mesopic conditions) and cover the contra-lateral eye with an 
eye-occluder (figure 10).  Avoid any direct light source (lamps or bright 
objects), behind your shoulder that would be in the visual field of the 
patient.  Such illumination sources will cause the IR-pupil measurement 
to be significantly smaller than it actually would be. 

 
Mixed (IR+visible) Pupillometry picture 
 

If you press the [P] button twice then you start a  "Mixed" illumination pupillometry 
image. You will see a white box with a cross at the bottom left of VK display (B in 
figure 9). The cone will lit up again and acquisition of the picture can be taken as 
usual (note a 3rd pressure of [P] as well as stopping acquisition by [Clr] and 
restarting, will return the cone in the “standard” light mode).    
 
Mixed acquisition mode, useful with some very low-contrast pupil, shall be attempted 
only after other methods to track it failed. See first in the on-line-Help of Scout 
software Release. 3.6.0 or later, the chapters about “Pupil Editing” and 
“Pupillometry”. 
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8 CLEANING, STERILIZATION AND MAINTAINANCE 
The medical personnel must take the responsibility to keep existing instruments and 
equipment functioning properly. The following simple steps serve as practical 
guidelines in establishing your care and maintenance program. 

8.1 CLEANING AND DISINFECTION  

The forehead-rest must be cleaned with alcohol or bactericide disinfectant before use 
with any patient. 
 
Sometimes, and whenever there is a possibility for skin allergy or cross infection, the 
external black conical surface of the optical head can also be cleaned with 
disinfectant, having care not to touch the two small photo-electronic tips of top of the 
cone. 
On special occurrences, or on a monthly basis, the optical head can be removed and 
cleaned inside. To perform this operation you must: 

• Grab the mires cone by its round flap with your full hand and remove it. 

• Clean inside the hole by blowing with a cleaning compress air can (or by low-
pressure compress air). 

• Re-insert the “cone” in its proper position. Press it firmly against the 
videokeratoscope. 

• Run a calibration, as described in the CALIBRATION SCREEN. 

8.2 STERILIZATION 

The Keratron® Scout videokeratoscope, computer and accessories used, but not 
those intended for the intra-operatory use, do not require sterilization since they are 
not expected to come in touch with the patient. 
 

CAUTION: In intra-operative mode the Videokeratoscope shall be 
covered with the proper disposable sterile sleeves just before use. 
Refer to the relevant instructions for use for a proper use of the sleeves. 

 
NOTE:  
To maintain system safety, the compliance to EN60601-1 leakage current limits should be tested at 
least once a year. Please, inquire with the Bioengineering Department in your clinic or with your local 
Optikon Distributor/Service Center.  
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9 TROUBLESHOOTING 

9.1  SOFTWARE INSTALLATION  

While the installation utiliy is copying Keratron Scout files in the PC hard disk the 
following message could appear: 
 
THE FILE YOU ARE COPYING IS OLDER THAN THE FILE PRESENT IN THE PC  

• In this case the first choice is to leave the newer file (already in the PC), 
without overwrite it with the older version. 

 
After the installation check the proper working of software running and test Scout 
program. If any error messages appears (Automation error, DLL xxx.dll not fount etc) 
the suggested actions are: 

• Unload the Scout software (see §6.4.2) 

• Reinstall it overwriting the files when prompted. 

9.2 THE SCOUT.INI FILE 

This files contain all the settings you make using the “Option Panel”, and other  
settings provided by the SW. 
 
This file must be used if: 

1. The SW hangs when starts. 

When this occurs try to rename (not delete!!) the “Scout.ini” file and restart the 
SW. 

 
2. Runtime error exporting tests. 
When this occurs open the Scout.ini file and then, in the “[Export]” section, check 
the “path” key,  probably it is pointing to a network path not available at the 
moment, or to an external drive not connected. Delete this row 
“path=x:\nnnn\mmmm\” and retry. 
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9.3 SHARING KERATRON® SCOUT WITH OTHERS 

If more than one user performs tests with Keratron® Scout, how can I separate 
tests to avoid confusion ? 
 
There are two ways to proceed: 
 

• Create your own “group” (e.g. your name) into the database, and save every 
test you perform in that “group”. (not recommended) 

or 

• Create more databases. (recommended) 

• Create one folder fo each user (using “Windows Explorer”). 

• Create one database for each folder (using “Keratron Scout” function, “File” -> 
“New Database”). 

• Every user will point to his database using “File->Open Database”, or from 
“File->Recent Database” list. 

9.4 CHANGING THE PC 

• Backup the Database(s) (on network, cd-rom…). 

• Backup the “C:\Keratron\Scout.ini” file (options, settings, MRU path). 

• Backup the “C:\Keratron\*.tb” file (toolbar settings). 

• Change the PC. 

• Reinstall the Keratron Scout software. 

• Reinstall the trial-sets. 

• Restore the database(s) (from network, cd-rom…). 

• Restore the “Scout.ini” into the “C:\Keratron” folder. 

• Restore the “C:\Keratron\*.tb” file (toolbar settings). 
 
NOTICE 
If you have installed some external programs, you have to re-enter the passwords. 
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9.5 MISCELLANEOUS PROBLEMS  

 
The following guide lists some malfunctions which may occur, the symptoms and the 
corrective actions. If the Keratron® Scout system remains inoperative even after 
performing the corrective actions indicated below, contact Optikon 2000 S.p.A. 
sales/service department. 
 
 SYMPTOMS CORRECTIVE ACTION 

  

A.C. Powered Units 
Keratron® Scout completely inoperative. 

a. The Docking Base a.c. power cord not connected. 
Connect power cord to control console and the 
power source. (See § 6.3.1) 

b. A.C. line fuse blown. Replace the line fuse. 
c. The Slit Lamp Cable has been not properly inserted 

or Keratron® Scout side or Docking Base side. 
Insert  the cable properly on both sides. 

Battery Powered Units 

Keratron® Scout completely inoperative. 
a. The Battery Pack is not properly inserted. Test the 

insertion of Battery Pack. (See § 6.3.2) 
b. The Battery Pack is  exausted. Recharge it. 

Acquisition and Processing Images 
The acquired image is broken into 
horizontal blocks. 
 

a. Check whether the Scout.exe and Tstscout.exe 
have been run at the same time (look at the 
Windows ToolBar). 

b. Check the presence of resident software that could 
interfere with USB port. Check the icons in 
Windows Toolbar (bottom right side) and de-
activate them.  

The map colors are not uniform, they 
sometimes change or they look dithered 
(“strange” colors). 
 

Check the “screen” settings, if they were 256. Keratron ® 

Scout requires a “True Color” mode, either 16, 24 or 32 
bit. 

The VK is not detected when in 
acquisition mode or when attempting to. 
 

a. Check that the docking-base is ON and that the VK 
is power supplied (LEDs OD/OS blinking 
alternatively). 

b. Check that the USB Cable between Docking Base 
and PC is inserted. 

c. Check the cable between the docking-base and the 
VK. 
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 SYMPTOMS CORRECTIVE ACTION 

  
d. In the motherboard BIOS setup utility check 

whether the USB port has been enabled.  

The Scout software cannot find some file 
(for example, DLL, INI files...). 
 

a. If it is possible, track the missing or damaged file 
and try to copy, move or overwrite it. 

b. Un-install the Scout.exe software, launch the PC 
and install the Scout software again. 

c. Re-install Windows and then Scout software.  

When battery operated the images 
acquired appear interrupted or not 
complete. 

a. Insert the Scout in the docking base FIRST and 
THEN launch the acquisition. 

b. Check the proper insertion of the Scout in the 
docking-base socket. 

When more images are processed the 
windows are empty or not complete, the 
maps are black or absent, or the pictures 
within the “accelerators” (icon buttons) 
disappear, or other non usual behaviours 
on windows update. 

 

a. Too few RAM memory in the PC available 

b. Check from menu ‘?’ ‘About’ ‘System Info...’ the 
percentage of system resources available. If it is 
less than 10%, close all possible programs that 
engage it or increase the RAM memory in the PC 
(suggested 64 Mb). However limit the excessive 
simultaneous use of resources in the system. 

The texts within the buttons or in the 
windows labels are non readable (cutted 
or new paragraph) 

a. Check the video board and its drivers (try different 
video mode and settings). Check that no  programs 
or settings in Windows can be cause of such a 
behaviour (for example Windows plus settings). 

b. Check the Windows “video settings” within “Screen 
properties”. 

Database 
The database is locked, it is not possible 
to open nor to close a database. 

 

a. Update the last software release and retry. 

Solution A 

a. Exit the Scout program. 

b. Rename the folder of the database in use (the 
selected database is indicated ot the bar at the top 
of the Scout desktop) e.g.: from “C:\My 
Documents\Database” in “C:\My 
Documents\Database_old”. 

c. Launch Scout program. 

d. By the “New database” menu command recreate 
the database “C:\My Documents\Database”, if the  
database was “C:\Keratron\Database” you don’t 
need to recreate it because it is the default 
database and therefore it is automatically created 
by the program if it was not found.  
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 SYMPTOMS CORRECTIVE ACTION 

  
e. Import tests from the folder “C:\My 

Documents\Database_old”. 

Solution B (if you are working in a LAN group) 

a. Exit (all) from the Scout program 

b. Open the file indtest.mdb (from the folder reported 
at the top of the Scout desktop). 

c. Open the ‘tabLock’ table . 

d. Modify the first record of the table from the present 
value to ‘Unknown’. 

e. Save and exit 

CAUTION!  
The Scout database is saved with DAO 3.5 
(Access ‘97). If you are using an Access 
version more updated, do not modify 
(saving) the database with the new version, 
because the modified file would not be 
readable from the Scout.  
If it was due to a wrong manouvre by a non 
expert user, reload the database and save it 
again with the DAO 3.5 version (“prior 
Access database version”) 

 

No test is visible in  the “database 
explorer” 

 

a. An empty database has been selected. 

b. Check whether the ‘Group’ selection has been 
pressed and no “Group” is present in the database. 

c. Check whether the ‘Operator’ selection has been 
pressed and no “Operator” is present in the 
database. 

 Note: The selections “Group” and “Operator” are of “toggle” 
type, and are independent from alphabetical or 
chronological selection 

Default settings do not correspond to the 
last ones, or the database looks 
“disappeared” 

 

a. Exit the Scout program 

b. Cancel o change the name (for more security) to 
the file “C:\Keratron\Scout.ini”. 

c. Restart the Scout program and  set the preferred 
options again. 
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11 APPENDIX 
 

Eye Detector Cone 

Artifact!!
Eyelashes fool the eye vertex 

detector 

Eye 
Detector Cone 

Ok !! 

Shadow projected
 by eyelashes

Caution !
The eyelashe’s shadow

crosses the horizontal line

The eyelashe’s shadow is well
above the horizontal line

The map shows a high 
power area 

Eyelashes Artifact 

Suggestions: 

•  Instruct the patient to WIDELY open BOTH eyes (if necessary you can 
   help the eye open with your fingers outside the cone). 
•  Acquire at least 2 images for eye, check for repeatability, eventually 
   saving only the best ones. 
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